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1. Introduction

1.1.

About This Manual

This document describes the use of the CODESYS programming environment and the Wince

runtime system for the Advantech ADAM-5560 series products.

Advantech provides add-on package for CoDeSys which allows developers and end users to

connected I/0O modules, perform configurations, and simple testing of the 1/0.

This manual supplies information about how to apply CoDeSys to control Advantech

ADAM-5560, including software installation, writing a new program in CoDeSys to testing

ADAM I/0 modules.

1.2.

Organization of This Manual

This user manual is divided into the following sections:

Introduction

Installations

Create and run a project

Advantech I/O Modules

Diagnosis and Troubleshooting

Introduction

This section gives the user a basic idea of this manual.



Installations

This section provides instructions on how to install CoDeSys and Advantech Add-on

Package

Create and run a project

This section gives the new user a walk-through in creating a simple program.

Advantech 1I/0 Modules
This section introduces the detail configuration and mapping variables of Advantech

ADAM I/0 modules

Diagnosis and Troubleshooting

This section provides instructions on how to troubleshooting and diagnose operation

mistakes or module errors.
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2. Installations

2.1. CODESYS Installation

Step1: Double click and execute the “Setup_CODESYSV<Version>.exe” to start the

installation assistant and then click Next to continue.

p
CODESYS V3.5 SP5 Patch 2 - InstallShield Wizard &

Welcome to the InstallShield Wizard for
- CODESYS V3.5 SP5 Patch 2

The InstallShield Wizard will install CODESYS V3.5 SP5
Patch 2 on your computer. To continue, click Next.

< Back [ Next > ][ Cancel ]




Step 2: You will then be prompted for the installation location. By default, CoDeSys will
install to C:\Program Files\3S CODESYS, but you can specify the location or folder name of

your choice. Click Next to proceed.

-
CODESYS V3.5 SP5 Patch 2 - InstallShield Wizard lil

Choose Destination Location
Select folder where setup will install files.

Setup will install CODESYS V3.5 SP5 Patch 2 in the following folder.
To install to this folder, click Next. To install to a different folder, click Browse and select
another folder.
Destination Folder
C:\Program Files\35 CODESYS\
InstallShield
| <Back | Newt> | | Cancel |

Step 3: Select all features and then click Next to proceed..



CODESYS V3.5 SP5 Patch 2 - InstallShield Wizard L=

Select Features
Select the features setup will install,

Select the features you want to install, and deselect the features you do not want to install.

- VICODESYS V3 Description
CODESYS Converter CODESYS V3... Next
CODESYS Gateway gz;lalnq obl'ggltfgnl?gd
W/ CODESYS OPC Server 3 51131a1_3||| IPLI “gl: programs.

- VICODESYS Gateway V2.3
“-W|CODESYS Control Win V3

1.35 GB of space required on the C drive
19.11 GB of space available on the C drive

InstallShield

| <Back | Newt> | [ Cancel |

e

»

Step 4: Complete to install CoDeSys and you'll see CoDeSys icon #ss. which is available on

the desktop. Click "Finish" to close the installation wizard.



CODESYS ¥3.5 SP5 Patch 2 - InstallShield Wizard

InstallShield Wizard Complete

The InstallShield Wizard has successfully installed CODESYS
V3.5 SP5 Patch 2. Click Finish to exit the wizard.

2.2. Add-on Package Installation

Now that you have CoDeSys on your system, you'll want to do a few steps to install add-on

package on your environment.

2.2.1 First-time Installation

Step 1: Install the latest version of the add-on package by double-clicking the executable

“Advantech ADAM CODESYS ADD ON.package”.
Note!

If you get an error stating “you must have administrative rights in order to install or

uninstall a package” on Window 7, you should turn UAC off.
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You must have administrative rights in order to install or uninstall a package.

\

(a) Open User Account Control Settings by clicking the Start button 0, and then

clicking Control Panel. In the search box, type uac, and then click Change User Account

Control settings.

(b) Move the slider to the Never notify position, and then click OK. ¥ If you're prompted

for an administrator password or confirmation, type the password or provide

confirmation. You will need to restart your computer for UAC to be turned off.

For more information about notification options, please refer to Microsoft website.

Step 2: When you are asked to choose setup type, choose the “Typical setup” and then click

Next.

22 Installation - Choose Setuap Type @

Advantech ADAM CODESYS ADD ON [1.0.0.0]
= 1
Please select the type of setup vou would like to perform. :D

(O Complete setup
All package components will be installed,

The most commonly used package components will be installed.

(O Customized setup

Full control over which package components are installed.
Recommended for advanced users.

(o ) | oo | (oo )
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Step 3: Select all versions and then click next.

22 Installation - Target Yersions E]

Advantech ADAM CODESYS ADD ON [1.0.0.0] )

One or more components in this package will modify existing versions. Please :E
select all the versions which should be upgraded by this package.

[V] CODESYS V3.5 SP5 Patch 2 Composer Dedicated
CODESYS V3.5 SP5 Patch 2

[ Cancel J[ < Back J[ Next > ]

Step 4: After the files have installed, you will see the completion screen. Click "Finish" to

close the installation wizard.
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i Installation - Setup Completed @

Advantech ADAM CODESYS ADD ON [1.0.0.0]

The package has been successfully installed. Click Finish to exit the wizard or Next to see the
SUTINALY.

[ net> | [ Finish |

2.2.2 Updating the Package

It's highly recommended that you uninstall the previous version package before updating
and installing new add-on package, so you can access to Control Panel and uninstall the

previous version package manually.

Alternatively, we can start CoDeSys and perform command Package Manager @ from the
menu (Tools -> Package Manager). Select the package you want to uninstall and then click

“Uninstall”. Click "Close" to close the package manager.

After uninstalling the old package successfully, please refer to First-time Installation.
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22 Package Manager

Currently installed packages:

S —

[ Nome Version | Inskliaiondels | Uplasinfo | Licemssinfo |
(9 [Advantech ADAM CODESYS ADDON | 1.0.0.0  2014/12/10 License info not available
¢ 3|

DDEDIWW [¥] Search updates in background

Del

Updates

CODESYS Store

H

E3
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3. Create and run a project

3.1. Start CoDeSys

&
Start CoDeSys by double-clicking the CoDeSys icon wss#.  which is available on the desktop.
Alternatively, you can start the CoDeSys programming system with

Start -> Programs -> 3S Software -> CoDeSys -> CODESYS V<version>
When you start the programming system the first time after first installation on the system,
you will be asked to choose the default collection of settings and features. Choose the

“Professional” and then click Start to proceed.

Choose Default Environment Settings E]

Before you begin using this software for the first time, you need to specify the type of
development activity you engage in the most. This information is used to apply a
predefined collection of settings to the development environment that is designed for
your development activity,

You can choose to use a different collection of settings at any time. From the Tools
menu, choose Options and then choose Features,

Choose your default environment settings:

Professional v

Description:

Recommended for users with advanced requirements. All features are avalable, and
some user interface aspects show more complexity in order to unveil all possibilities
of the system.

[ stat |[ et |

Before creating a project, make sure that Advantech ADAM add-on package is installed

successfully. Choose Package Manger from the Tools menu:

If the Advantech ADAM add-on package didn’t show in manager, please refer to Chapter 2

and update your package.



Sortby: [Name

Version Installation date Updateinfo  License info
:: | [Mvan‘bed'l ADAM CODESYSADD ON | 1.0.0.0 2014/12/5 License info not availat
# CODESYS Package Designer 3.5.5.0 2014/11/26 No license required

< | L

[7] Display versions [i7] Search updates in background

3.2. Create a Project

Step 1: To create a new project, choose command New project from the File menu:

In the New Project dialog select Standard project in the ‘Templates’ field and enter a Name

and a Location path for the project file. Press OK to confirm.
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Categories: Templates:

{3 Libraries ' - -
(3 Projects [ B =

Empty project  EEGGEEG] Standard
project project w...

|A project containing one device, one application, and an empty implementation for PLC_PRG

Name: |Advantech_Sample_Project
Location: ;C:koocurnents and Settings\USER\My Documents v B

[ OK ][ Cancel ]

Step 2: You will then be prompted for choosing devices. Choose device Advantech
ADAM-5560 WinCE V3 (ADVANTECH) and programming language Structured Text (ST)

(depend on developer) for PLC_PRG. Press OK to open the new project.
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Standard Project @

. You are about to create a new standard project. This wizard will create the following
— i I objects within this project:

- One programmable device as specified below

- A program PLC_PRG in the language specified below

- A cydlic task which calls PLC_PRG

- & reference to the newest version of the Standard library currently installed.

Device: ' Advantech ADAM-5560 WinCE ¥3 (ADVANTECH) >
PLC_PRGin: é_Stru-:tured Text (ST) ¢

[ OK ][ Cancel ]

Step 3: The project name now will appear in the title bar of the CoDeSys user interface and

the Devices window.

Devices - I
= ) Advantech_Sample_Project
= m Device (Advantech ADAM-SS60 WinCE ¥3)
= [ Plc Logic
= Q Application
.ﬂ Library Manager
£] PLC_PRG (PRG)
= (&4 Task Configuration
= & MainTask
&) PLC_PRG
= Backplane (Backplane)
<Empty > (<Empty>)
<Empty > (<Empty >)
<Empty > ( <Empty>)
<Empty > (<Empty >)
<Empty > (<Empty>)
<Empty > (<Empty >)
<Empty> (<Empty>)

nmnmnnmnrnrnn

3.3. Write a Program

In the Devices window, double-chick PLC_PRG(PRG) and language editor window will open.

The editor consists of a declaration part (upper) and a body part (lower), separated by a
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screen divider. The declaration part shows line numbers at the left border and the

embracing keywords "VAR" and "END_VAR" for the variables declaration.

Moevices 7T T @ x
= ) Advantech_ Sample_Froject v
= [E} Device (Advantech ADAM-5560 WinCE V3)
= B Pl Logic
= ‘Q Application

'ﬂ Library Manager
[£] PLC_PRG (PRG)
= E Task Configuration
= & MainTask
#] pLc_PrG
= Backplane (Backplane)
<Empty > (<Empty>)
<Empty> (<Empty>)
<Empty > (<Empty>)
<Empty> (<Empty>)
<Empty > { <Empty>)
<Empty> (<Empty>)
<Empty> (<Empty>)

nnRannmnn

Device window

mn

4

[£] PLC_PRG x

rrocrax Pic R eclaration part

VAR
i_base: INT;
i_height: INT:
i_radius: INT;
EHD VAR
VAR CONSTANT
const_PI: REAL :=
EHD VAR

3.14;

// Calculate triangle area

i_base := 5; BOdy part
i_height := 7;
d_area := i_base * i_height * 0.5;

// Calculate circle area
i_radius := 6;
d_area := i_radius * i_radius * const_PI:

- i o - - - = - — - = = = = = = ]

In the declaration part of the editor put the cursor behind VAR and press the Return-key.

A new empty line will be displayed where you enter the declaration of variables.

Here, we write a simple program to calculate the area of triangle and circle, so declare

i_base, i_height, i_radius which are of type INTEGER, d_area of type REAL:

PROGRAM PLC_PRG
VAR
i_base: INT;
i_height: INT:
i_radius: INT;
END VAR
VAR CONSTANT
const_FPI: REAL :=
END VAR
VAR
d_area: REAL;
END VAR

3.14;

In the body part of the PLC_PRG editor put the cursor in line 1 and enter the following lines:
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// Calculate triangle area

i_base := 5;

i_height := 7;

d_area := i_base * i_height * 0.5;

S/ Calculate circle area

i_radius := 6;

d_area := i_radius * i_radius * const_PI:

We need to check the program for syntactic errors and perform command Build £ from

the menu (Build -> Build) or press <F11>:

Messages - Totally 0 error(s), 0 warning(s), 0 message(s)

Build - |00=n‘or(s)|®0w.ming(s)|00nwssaxe(s)| X

Description
|------ Build started: Application: Device.Application -------
typify code ...
Compile complete -- 0 errors, 0 warnings

Note!

No code will be generated in this case. Error messages will be displayed in the

Messages window which is placed at the lower part of the user interface per default.

3.4. Connect to the Target Device

In this section, we want to discuss how to connect to ADAM-5560.
We need to set the active application by using Device editor. It displays an icon of
programming device, the current gateway and the target device with their connection status.

The Device editor opens by double clicking the device name in the device tree.

Devices -~ 8 % (5] mces ] Device x
g —g—— e =
¥ — |[ Communication Settings | Appications | Fies | Log | PLC settings | PLC shell | Users and Groups | Access Rights | Task deployment | Status | 1 Information

Device (Advantech ADAM-5560 WINCE ¥3) -
T PR

= Took
= ) application
M) Lbeary Manager )
\B] PLC_PRG (PRG) -
= [ Task Configuration
= ¢ MainTask = e
&) rc_prc . ® .
= (@ sadiplane (Badkplane) e
<Emplty> { <Empty>)
<Empty> {<Empy>) ot evary-1] v [0075] (sctive) L/
<Empty > { <Empty >}
<Empty> (<Empty>) o
<Empty> (<Empty>)
<Empty> (<Empty>) Post:
<Empty> (<Empty>) 1’y

nannnnn
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Click the Scan network button to search for available devices in your local network. You will
then be prompted for the device selection. Choose your target device and click OK to

proceed.

Select Device @

Select the network path to the controller:

(= ghe Gateway-1 Device Name: 4
_'B CODESYS Control WinCE 3 [0060] CODESYS Control -
ﬂ CODESYS Control WinCE ¥3 [0051] WinCE ¥3

[ |cODESYS Control WinCE v3[0075] |

Device Address:
10075

Target Yersion:
3.5.5.30

Target Yendor:
ADVANTECH

Target ID:
1635 0001

Target Name:

ADAM-5560 WinCE

o J[ come ]

In Device editor, it will show the connection status. Please check that the colored status

points are all in green.

Note!

Meaning of the colored status point on the gateway and the device:
Red: Connection cannot be established
Green: Connection established

Black: Connection not defined
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5] Pcere 1) pevice x
| Communication Settings | Applcations | Fies | Log | PLC settings
| Scannetwork... Gateway - Device =

PLC shell | Users and Groups | Access Rights | Task deployment = Status

i Information

Gateway
ateway-1

IP-Address:
localhost

Port:
1217

3.5. Run the Application

[0075) (active)

Device Name:
CODESYS Control WinCE ¥3

Device Address:
0075

Target ID:
1635 0001

Target Type:
40%

Target Vendor:
ADVANTECH

Target Version:
3.55%

We can download the application by performing command Login “% from the menu

(Online -> Login) or press <Alt+F8>. You will then be prompted for choosing login options.

Here, we choose “Login with download” for the first time and click OK to proceed.

Note!

Meaning of login options:

“Login with online change”: Only the modified objects will be loaded.

“Login with download”: The complete application will be loaded and initialized

completely. “Login without any change”: The latest modifications will not be loaded.

Application changed since last download. What do you want to do?

.7

() Login with online change.

(® lLogin with download. |

(O Login without any change.

I OK I[ Cancel J
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We run the program by performing command Start .* from the menu (Debug -> Start) or
press <F5>. The online view of PLC_PRG will be opened: In the upper part a table shows the
watch variables in application. In the lower part you see the code lines as entered in offline
mode, supplemented by the little inline monitoring windows behind each variable, showing

the actual value.

Stop the program by performing command Stop ® from the menu (Debug -> Stop) or press
<Shift+F8>.
If you want to change into the offline mode and disconnect the programming system from

the target device, perform command Logout % from the menu (Online -> Logout) or press

<Ctrl+F8>.
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4. Advantech I/0 Modules

4.1. InsertI/O Modules into CODESYS

We can add and configure Advantech I/O modules as objects in the device tree.
Note!
ADAM-5560 does NOT support hot plugging for I/0 modules.

An empty slot is identified by icon K and entry <Empty> (<Empty>). An already occupied

slot shows icon ®and the device name.

Choose one of available slot and click Plug Device in context menu.

= ) Advantech IO = ) Advantech IO
= Y Device (Advantech ADAM-5560' = [ Device (Advantech ADAM-S560 WinCE V3)
= 0 Plc Logic = 80 Plc Logic
= Q Application = Q Application
m Library Manager m Library Manager
|£] PLC_PRG (PRG) |£) PLC_PRG (PRG)
= (&4 Task Configuration = (&4 Task Configuration
= @ MainTask = @ MainTask
&) PLC_PRG &) PLC_PRG
= Backplane (Backplane) = Backplane (Backplane)
K <Empty>(<Empty>) ——— © {j ADAM_S0S1 (ADAM 5051)
L <Empty>{<Empty>)  Plug Device K <Empty> (<Empty>)
K <Empty> (<Empty>) K <Empty> (<Empty>)
£ <Empty> (<Empty>) K <Empty> (<Empty>)
E  <Empty> (<Empty>) E  <Empty> (<Empty>)
K <Empty> (<Empty:>) E  <Empty> {<Empty>)
K <Empty> (<Empty>) E  <Empty> (<Empty>)

It will open the Plug Device dialog, where you can choose one of available devices for the
current slot. The existing entry will be replaced by the new one in an occupied slot.

Click Plug Device to proceed and then press Close to close the device dialog.

Note!

You can remove the existing device by click Delete < in context menu.
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0 Plug Device E

Name: ADAM_S013

Action:
() Plug device
Device:
Vendor: | <l vendors>
Name Yendor Version
= (4 miscelaneous
“ ADAM S013 ADVANTECH 3.5.5.30
(i ADAM 5017 ADVANTECH 3.5.5.30

Ij apamso17p ADVANTECH  3.5.5.30
[ ADAMSODI7UH  ADVANTECH  3.5.5.30

(i ADAM 5018 ADVANTECH 3.5.5.30
U ADAM S018P ADVANTECH 3.5.5.30
§j ADAM 5024 ADVANTECH  3.5.5.30
Ij apamMsos1 ADVANTECH  3.5.5.30
§j apamsosz ADVANTECH  3.5.5.30
[ apamsos3 ADVANTECH  3.5.5.30
i apamsoss ADVANTECH  3.5.5.30
L apam sose ADVANTECH  3.5.5.30 e
[¥] Group by categary
[[] Display all versions (For experts only)
[] Display outdated versions
Information:
{  Name: ADAMS013
Vendor: ADVANTECH
Groups:
Version: 3.5.5.30 (ﬁ
Model Number: -

Description: 3 Channels RTD Input Module

Plug selected device into the slot
<Empty>

©®  (You can select another target node in the navigator while this window is open.)

[ PugDevice | [ Close

4.2. Map Variables to I/0 Modules

In this section, we want to discuss how to map variable of program to Advantech I/0
modules. For more details on creating a new program please refer to chapter 3.

Here, we declare bValue in declaration part and set true in body part.

PROGRAM PLC_PRG
VAR

bValue: BOOL;
EHD VAR

bValue:= true;

Open Module Editor by double clicking the device name in the device tree. Double-click on

the variable column and choose mapping variable by clicking the button =J. In this example,
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we try to map the variable (bValue) to channel 0, so we double-click on the first row of

variable column.

# Status 1/O Mapping | Status | i Information |

Channels
Variable Mapping Channel Address Type Unit Description
" | = DO-0 %QX0.0  BIT Digital Output pin 0
" DO-1 %QX0.1  BIT Digital Output pin 1
" DO-2 %QX0.2  BIT Digital Output pin 2
" DO-3 %Qx0.3  BIT Digital Output pin 3

It will open the Input Assistant Dialog, where you can choose one of available devices for
the current slot. The existing entry will be replaced by the new one in an occupied slot.

Click Plug Device to proceed.

| Text search | Categories

Yariables o Name Type Address Origin
= £} application Ar p
= [Brcrre %
 bvalue ] 00

+ @ 1oConfig_Globals V4R_ 6L O5AL

=) Structured view Filter: |MNone v

Show documentation
Documentation:

bvalue: BOOL;
(VAR)

[ OK ][ Cancel ]
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Now, we can download the application by performing command Login and then performing
command Start. The channel-0 of I/0 module will be lit up.

¥ Status IO Mapping | Status | 1. Information

Channels
Yariable  Mapping Channel  Address Type Curren...  Prepar..  Unit Descri...
"$A. T$ DOO %Qtérrr BIT Digital O...
" DO-1 %QX... BIT Digital O...
" DO-2 %QX... BIT Digital O...
Note!

If the Advantech modules are correctly configured, it will show a green circle icon
next to the device name in the device tree. If it shows a red triangle A , see the

chapter 5 for troubleshooting.

@@ Backplane (Backplane)
€ [; ADAM_S056 (ADAM 5056)
At [1 ADAM_S017 (ADAM 5017)
<Empty > (<Empty>)
<Empty > (<Empty >)
<Empty > (<Empty>)
<Empty > (<Empty >)
<Empty > (<Empty>)

nmanrnnn

4.3. Support List

Advantech provides 21 types of ADAM-5000 I/0 modules for various applications so far.
Following table is the I/O modules support list. In the following section, we will introduce 1/0

modules according to their types.

Module Name Specification Reference
ADAM-5013 3-ch RTD Input Isolated
ADAM-5017 8-ch Al Isolated

Analog Input ADAM-5017P  8-ch Al w/Independent Input Range Isolated
ADAM-5017UH 8-ch Ultra High Speed Al (200KHz) Isolated
ADAM-5018 7-ch TC Input Isolated

ADAM-5018P  7-ch TC Input w/Independent Input Range Isolated
Analog Output ADAM-5024 4-ch AO Isolated

ADAM-5051 16-ch DI Non-isolated
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ADAM-5051D  16-ch DI w/LED Non-isolated
Digital Input ADAM-5051S  16-ch Isolated DI w/LED Isolated
ADAM-5052 8-ch Isolated DI w/LED Isolated
ADAM-5053 32-ch Isolated DI Isolated
ADAM-5056 16-ch DO Non-isolated
ADAM-5056D  16-ch DO w/LED Non-isolated
Digital Output ~ ADAM-5056S  16-ch Isolated DO w/LED Isolated
ADAM-5056S0O 16-ch Source Type Isolated DO w/LED Isolated
ADAM-5057S  32-ch Isolated DO Isolated
Digital I/0 ADAM-5055S  16-ch Isolated DI/O w/LED Isolated
Relay Output ADAM-5060 6-ch Relay Output Isolated
ADAM-5069 8-ch Power Relay Output w/LED Isolated
Counter/ ADAM-5081 4-ch/8-ch High Speed Counter/Frequency Isolated
Frequency

4.4. Digital Input Modules

In this section, we are going to introduce digital input modules.

The Module editor opens by double clicking the device name in the device tree. It consists of

three tab pages, that is, Status 1/O Mapping, Status and Information.

Status I/0 Mapping: Show the I/O mapping status between variable to module channel. It

consists of seven columns.

Mapping: The mapping status of each variable.

Note!

There are two categories of variables: Channel values and Error ID.

Channel values: The data type of each channel is in single bit. If the value is “true”,

it means that the channel is on; “false” for off.

For detailed variable mapping information, see chapter 4.2.
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Error ID: This variable holds the status of I/O module and its data type is in Word
(16 Bits). Get module error ID by mapping the last variable in table. For detailed

error ID information, see chapter 5.3.

Address: The starting physical address of the variables for this I/0O group. The board
shown below has 16 digital inputs. This will require either 16 Boolean addresses or 2

Byte addresses.

Note!

Meaning of address expression:

% = Directly Mapped variable

I = Physical Input

X = Single bit

S(N1). $(N2) = The starting address. The first number means the starting byte; the

second number means the starting bit.
Type: The data type of each variable.
Description: The description of each variable.
Status: The reserved page.

Information: Provide the brief information to current module.
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| ¥ Status IO Mapping | Status | i Information

Channels
Variable Mapping Channel Address Type Unit Description

“» DI-0 2%I%0,0 BIT Digital Input pin 0
» DI-1 %IX0,1 BIT Digital Input pin 1
“» DI-2 %IND.2 BIT Digital Input pin 2
“» DI-3 %IXD.3 BIT Digital Input pin 3
“» DI-4 %IX0.4 BIT Digital Input pin 4
“» DI-5 2%I%0.5 BIT Digital Input pin 5
» DI-6 %IND.6 BIT Digital Input pin &
“» DI-7 %IND.7 BIT Digital Input pin 7
e DI-8 %IX1.0 BIT Digital Input pin &
“» DI-9 %IX1.1 BIT Digital Input pin 9
“» DI-10 %IX1.2 BIT Digital Input pin 10
» DI-11 %IX1.3 BIT Digital Input pin 11
s DI-12 %IX1.4 BIT Digital Input pin 12
“» DI-13 %IX1.5 BIT Digital Input pin 13
“» DI-14 %IXL.6 BIT Digital Input pin 14
“» DI-15 %IX1.7 BIT Digital Input pin 15
i %IW1 WORL Error ID currently ha

4.5. Digital Output Modules

In this section, we are going to introduce digital output modules.
The Module editor opens by double clicking the device name in the device tree. It consists of

three tab pages, that is, Status I/O Mapping, Status and Information.

Status I/0 Mapping: Show the I/0 mapping status between variable to module channel. It

consists of seven columns.
Mapping: The mapping status of each variable.
Note!

There are two categories of variables: Channel values and Error ID.
Channel values: The data type of each channel is in single bit. Set the value to
“true” for switching on the channel; “false” for switching off.

For detailed variable mapping information, see chapter 4.2.

Error ID: This variable holds the status of I/O module and its data type is in Word
(16 Bits). Get module error ID by mapping the last variable in table. For detailed

error ID information, see chapter 5.3.

32



Address: The starting physical address of the variables for this I/0 group. The board
shown below has 16 digital inputs. This will require either 16 Boolean addresses or 2

Byte addresses.

Note!

Meaning of address expression:

% = Directly Mapped variable

Q = Physical Output

X = Single bit

S(N1). $(N2) = The starting address. The first number means the starting byte; the

second number means the starting bit.

Type: The data type of each variable.

Description: The description of each variable.

Status: The reserved page.

Information: Provide the brief information to current module.

B Status IfO Mapping | Status | i~ Information

Channels
Variable  Mappmg  Chanmel  Address Type Ut Description

i) DO-0 %QXD.0  BIT Digital Output pin 0
"» DO-1 %QxD.1  BIT Digital Output pin 1
o DO-2 %QXD.2  BIT Digital Output pin 2
e DO-3 %QX0.3  BIT Digital Output pin 3
e DO-4 %QX0.4  BIT Digital Output pin 4
"» DO-5 %QX0.5  BIT Digital Output pin 5
"¥ DO-6 %QX0.6  BIT Digital Output pin &
" DO-7 %QX0.7  BIT Digital Output pin 7
i’ DO-8 %QX1.0  BIT Digital Output pin &
" DO-9 %QX1.1  BIT Digital Output pin 9
i ] DO-10 %QX1.2  BIT Digital Output pin 10
"» DO-11 %QX1.3  BIT Digital Output pin 11
¥ DO-12 %QX1.4  BIT Digital Output pin 12
") DO-13 %QX1.5  BIT Digital Output pin 13
i ] DO-14 %QX1.6  BIT Digital Output pin 14
"» DO-15 %QX1.7  BIT Digital Output pin 15
* %IWD WORC Error ID currently happened in the /O de
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4.6. Analog Input Modules

In this section, we are going to introduce analog input modules.
The Module editor opens by double clicking the device name in the device tree. It consists of

four tab pages, that is, Status Configuration, Status I/O Mapping, Status and Information.

Status Configuration: Provide the channel status page for setting channel ranges.

Double-click on the value column of the particular channel.
Note!

For ADAM-5013, ADAM-5017 and ADAM-5018, all channels are restricted to the same

channel range and base on the first channel (ch-0).

Status Configuration | ¥ Status IfO Mapping | Status | 1. Information

Parameter Type Value Default Value  Unit Description
@ TypeOf AI-O Enumeration of BYTE 4020 M
® TypeOf Al-1 Enumeration of BYTE 420 MAs
@ TypeOf Al-2  Enumeration of BYTE 420 mis
® TypeOf AI-3 Enumeration of BYTE 4020 mA
@ TypeOf Al-4 Enumeration of BYTE 4~20 mA
® TypeOf AI-S Enumeration of BYTE 4020 Mk
@ TypeOf Al-6 Enumeration of BYTE 420 M
@ TypeOf AI-7 Enumeration of BYTE 4~20 mA 4~:20 mA

Status I/0 Mapping: Show the /O mapping status between variable to module channel.

Mapping: The mapping status of each variable.

Note!

There are two categories of variables: Channel values and Error ID.
Channel values: The data type of each channel is in REAL.

For detailed variable mapping information, see chapter 4.2.

Error ID: This variable holds the status of I/O module and its data type is in Word
(16 Bits). Get module error ID by mapping the last variable in table. For detailed

error ID information, see chapter 5.3.
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Address: The starting physical address of the variables for this I/0 group. The board

shown below has 8 analog inputs. This will require 8 DWORD addresses.

Note!

Meaning of address expression:
% = Directly Mapped variable

I = Physical Input

D = Double word (32 Bits)

$(N) = The starting address.
Type: The data type of each variable.

Description: The description of each variable.

Status Configuration || ¥ Status IfO Mapping | status | i Information

Channels
Variable Mapping Charinel Address Type Unit Description
“» AL-0 “lID1 REAL Analog input 0
» Al-1 %ID2 REAL Analog input 1
i Al-2 *%6ID3 REAL Analog input 2
i Al-3 %104 REAL Analog input 3
i Al-4 %105 REAL Analog input 4
“» Al-S %ID6 REAL Analog input 5
“» Al-6 “lD7 REAL Analog input 6
i Al-7 *%LID8 REAL Analog input 7
4 Errarl % IW1S Error ID current

Status: The reserved page.

Information: Provide the brief information for current module.

4.7. Analog Output Modules

In this section, we are going to introduce analog output modules.
The Module editor opens by double clicking the device name in the device tree. It consists of

four tab pages, that is, Status Configuration, Status I/O Mapping, Status and Information.

Status Configuration: Provide the channel status page for setting channel ranges.

Double-click on the value column of the particular channel.
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Status Configuration _ ¥= Status IJO Mapping | Status

Parameter
® TypeOf AO-0
® TypeOf AO-1
® TypeOf AO-2
® TypeOf AQ-3

Type
Enumeration of BYTE
Enumeration of BYTE
Enumeration of BYTE
Enumeration of BYTE

Value
0~20mA v

4~20 mA
O~10V

i. Information

Default Valve  Unit Description
0~20 m&
0~20 mé
0~20 méa
0~20 ma

Status I/0 Mapping: Show the I/0 mapping status between local variable to module

channel.

Mapping: The mapping status of each variable.

Note!

There are two categories of variables: Channel values and Error ID.

Channel values: The data type of each channel is in REAL.

For detailed variable mapping information, see chapter 4.2.

Error ID: This variable holds the status of I/O module and its data type is in Word

(16 Bits). Get module error ID by mapping the last variable in table. For detailed

error ID information, see chapter 5.3.

Address: The starting physical address of the variables for this I/O group. The board

shown below has 4 analog outputs. This will require 4 DWORD addresses.

Note!

Meaning of address expression:

% = Directly Mapped variable

Q = Physical Output

D = Double word (32 Bits)

$(N) = The starting address.

Type: The data type of each variable.

Description: The description of each variable.
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Status Configuration | = Status I/O Mapping | Status | i Information

Channels
Variable Mapping Channel Address Type Unit Description
"® AC-0 %QDO0 REAL Analog output 0
"$ AO-1 %QD1 REAL Analog output 1
"$ AD-2 %QD2 REAL Analog output 2
'1 AOD-3 QD3 REAL Analog output 3
44 o4 IWS3 Error 1D current

Status: The reserved page.

Information: Provide the brief information for current module.

4.8. Relay Output Modules

In this section, we are going to introduce relay output modules.
The Module editor opens by double clicking the device name in the device tree. It consists of

three tab pages, that is, Status 1/O Mapping, Status and Information.

Status I/0 Mapping: Show the I/O mapping status between local variable to module channel.

It consists of seven columns.
Mapping: The mapping status of each variable.
Note!

There are two categories of variables: Channel values and Error ID.
Channel values: The data type of each channel is in single bit. Set the value to
“true” for switching on the channel; “false” for switching off.

For detailed variable mapping information, see chapter 4.2.

Error ID: This variable holds the status of I/O module and its data type is in Word
(16 Bits). Get module error ID by mapping the last variable in table. For detailed

error ID information, see chapter 5.3.

Address: The starting physical address of the variables for this I/O group. The board
shown below has 6 relay outputs. This will require either 6 Boolean addresses or 1 Byte
address.
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Note!

Meaning of address expression:

% = Directly Mapped variable

Q = Physical Output

X = Single bit

$(N1). $(N2) = The starting address. The first number means the starting byte; the

second number means the starting bit.

Type: The data type of each variable.

Description: The description of each variable.

Status: The reserved page.

Information: Provide the brief information to current module.

¥ Status I/OMapping | Status | i Information

Channels
Vanable Mapping Channel Address Type Ut Description
"$ DO-0 %QX0.0  BIT Digital Output pin 0
" DO-1 %Qxo.1  BIT Digital Output pin 1
9 DO-2 %Q¥0.2  BIT Digital Output pin 2
) DO-3 %QX0.3  BIT Digital Output pin 3
g DO-4 %QX0.4  BIT Digital Output pin 4
) DO-5 %QX0,5  BIT Digital Output pin &
“» TBIWO ' Error 1D currently |

4.9. Counter/Frequency Modules

In this section, we are going to introduce counter/frequency modules.
The Module editor opens by double clicking the device name in the device tree. It consists of

four tab pages, that is, Status Configuration, Status I/O Mapping, Status and Information.

Status Configuration: Provide the channel status page for setting channel ranges.
Double-click on the value column of the particular channel. The module contains counter

channels and DO/Alarm channels as shown image below.
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For counter channels, we offer five types of counting mode (Bi-direction, Up/Down, A/B
Phase) for different application purposes. The counter will count up or down according to

your applications. This counting function helps us obtain the most accurate data.

Before starting counting, we have to set Startup Value, i.e. Initial value, and the default is 0.

The data type of startup value is in DWORD.

Parameter Type Value Defanlt Value  Unit Description

= @ CIRO Channel config of CTR O
¥ Mode Enumeration of BYTE Bi-directory v Bi-directory
# Startup Yalue DWORD(16#0..16#FFFFFFFF) 5 gractory o

= @WCR2 Up{Down Channel config of CTR 2
# Mode Enumeration of BYTE :-‘g:éi Bi-directory
# Startup Value DWORD(16#0.. 16 #FFFFFFFF) 0

= @wCIR4 Channel config of CTR 4
& Mode Enumeration of BYTE Bi-directory Bi-directory
#® Startup Value DWORD(16#0., .16 #FFFFFFFF) 0 1]

= @ CIR6 Channel config of CTR &
# Mode Enurneration of BYTE Bi-directory Bi-directory
® Startup Value DWORD(16#0.. 16 #FFFFFFFF) 0 0

We can also set Digital Filter (in us) for high or low level minimum signal width to reduce

noise spike.

Every counter channel can measure the frequency of assigned time window and the range is
from 0.1Hz to 1MHz. We can assigned Frequency Acquisition Time (in ms) to get counter

number within the time range.

@ Digital Filter UINT(1..65000) 1 1 us Digital Filter
¥ Freq. Acq. Time UINT(1..1000) 1 1 ms Freq. Acq. Time

For DO/Alarm channels, you can change the setting by double-clicking and selecting an item

from the pull-down menus:

Mode: Select "DO" or "Local Alarm Latch"

Alarm Type: Select "High" or "Low", i.e. high alarm or low alarm.

Alarm Limit: Set alarm limit value.

Sending High alarm High alarm limit

Initial value
Sending Low alarm

Low alarm limit




Alarm Mapping: Select counter channel number.

= @ DOJALMO Channel config of DOJALM 0
® Mode Enumeration of BYTE Local Alarm... Do
® Alarm Type Enumeration of BYTE High Low
% Alarm Mapping Enumeration of BYTE Channel 2 Channel 0
@ Alarm Limit DWORD 100 0
= & DOJALM 1 Channel config of DOJALM 1
# Mode Enumeration of BYTE Local Alarm... Do
# Alarm Type Enumeration of BYTE Low Low
# Alarm Mapping Enumeration of BYTE Channel 0 Channel 0
# Alarm Limit DWORD 0 1]

Status I/0 Mapping: Show the I/O mapping status between local variable to module

channel.

Mapping: The mapping status of each variable. For detailed variable mapping

information, see chapter 4.2.
Note!

There are three categories of variables: Status variables, Setting variables and

Error ID.

Status variables: These variables are read-only and hold the module status.

Name Data type Information

Counting Number | DWORD The total counting number.

Counting Status Single Bit “true” for starting counting; “false” for stop.
Overflow Status Single Bit “true” for overflow

Latch Status Single Bit “true” for reach alarm latch.

Setting variables: These variables are read-write. You can change the setting by

changing the column value.

Name Data type Information

DO value Single Bit Set the value to “true” for switching on the channel;

“false” for switching off.
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Clear to Startup Single Bit Set “true” for set current counting number to startup

counting number.

Clear Overflow Single Bit Set “true” for clear overflow.

Clear Alarm Latch | Single Bit Set “true” for clear the alarm latch.

For detailed variable mapping information, see chapter 4.2.

Error ID: This variable holds the status of I/O module and its data type is in Word
(16 Bits). Get module error ID by mapping the last variable in table. For detailed

error ID information, see chapter 5.3.

Address: The starting physical address of the variables for this I/0 group. The board
shown below has 4 counter inputs and 4 digital outputs. This will require 4 DWORD

addresses for counter channel values and 4 Boolean addresses for digital outputs.

Note!

Meaning of address expression:

% = Directly Mapped variable

I = Physical Input Q = Physical Output

X = Single bit D = Double word (32 Bits)

$(N) = The starting address.
Type: The data type of each variable.

Description: The description of each variable.
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| Status Configuration | ™= Status 1/0 Mapping | status | i Information |

Channels
Variable Mopping  Channel  Addeess Type Unit  Description

» CTR-0 %ID0 DWORD Counter 0
4 CTR-2 %ID1 DWORD Counter 2
» CTR-4 %ID2 DWORD Counter 4
4 CTR-6 %ID3 DWORD Counter 6
4 CTR-0 Co... %IX16.0  BIT Counter 0 Counting Status
» CTR-2 Co... %IX16.1  BIT Counter 2 Counting Status
4 CTR-4 Co... %IX16.2  BIT Counter 4 Counting Status
» CTR-6 Co... %IX16.3  BIT Counter 6 Counting Status
49 CTR-0Ov..  %IX16.4  BIT Counter 0 Overflow Status
L) CTR-20v..  %I%16.5 BIT Counter 2 Overflow Status
49 CTR-4 Ov..  %IX16.6  BIT Counter 4 Overflow Status
4 CTR-6 Ov..  %I¥16.7 BIT Counter 6 Overflow Status
» ALM-0 Lat..  %IX17.0 BIT Counter 0 Latch Status
4 ALM-1 Lat.. o171 BIT Counter 1 Latch Status
4 ALM-Z Lat..  %IX17.2  BIT Counter 2 Latch Status
4 ALM-3 Lat..  oIx17.3  BIT Counter 3 Latch Status
"» DO-0 %QKO.0  BIT Digital Output pin 0
" DO-1 %QX0.1  BIT Digital Output pin 1
"» DO-2 %QrO.2 BT Digital Qutput pin 2
:0 DO-3 %QxD.3  BIT Digital Output pin 3
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Chapter 5



5. Diagnosis and Troubleshooting

5.1. Error Notification

In chapter 4, we introduce how to write a program to control Advantech I/O modules. If the
Advantech modules are correctly configured, it will show a green circle icon - next to the

device name in the device tree after performing command Login and Start. If it shows a red

triangleA , it means that I/0 module encountered several errors while running.

I Backplane (Backplane)
¢ §J ADAM_S0S6 (ADAM 5056)
A §j apam_S5017 (ADAM S017)
<Empty > (<Empty =)
<Empty > { <Empty >)
<Empty > { <Empty >)
<Empty > { <Empty >)
<Empty > { <Empty >)

nmnnnn

5.2. Log Information

We can get log information from Advantech CoDeSys or target machine, i.e. ADAM-5560.

In Advantech CoDeSys development environment, double click the device name in the
device tree to open Device editor. Select the Log dialog and it will display the log of the

Advantech I/O module. A log entry line contains the following information:

Severity: There are four categories: warnings, errors, exceptions, information. The display of
the entries of each category can be switched on or off by using the corresponding button
from the bar above the listing. Each button always contains the current number of loggings

in the respective category.
Time Stamp: Date and Time.

Description: Description of the event, for example “Device not found or not matched."
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Component: ID and name of the component

Devices L . 4

2] pevice x
= {3 Advantec Progect =]
=( [} Device (Advankech ADAM-SS50 WincE V3) T P jon Settings | Applications | Filles | Log PLC settings | PLC shell | Users and Groups | Access Rights
I:U-ﬂ e K ; % I | :
O Double click | offinetogong [Jutc e
Library Manager = (e
[8) pLc_pra (PrG) '.!I'l:lwanhq[s)[ﬂZuror(s) E0 ) & 1320 ion(s) (D 9 debug {s) <Allc
< i?;"::‘jx“" Severity Time Stamp  Description Component
&) ne e o 0 <Siot 1> Device not found or not matched  ToDrvADAM
- o 0 <Slot 1> Device not found o not matched  ToDrvADAM

On target machine, we can also get error ID from CoDeSys WinCE runtime.

In the ADAM-5560 environment, open runtime by double-clicking the runtime icon @

which is available on the lower-right corner of the desktop.

Get error ID by performing command Errors from the menu (Info -> Errors).

CODESYSCaontrolWinCE

Commands Info
Errors

IoDrvADAN :
<Slot 1> Device not found
iErrorID 32768, iInfolD O
IoDrvADAN :
<Slot 1> Device not found
iErrorID 32768, iInfolD O

5.3. ErrorlID

Following table is the error ID for I/O modules.

or not matched

or not matched

Error ID Description

0x8000

The module didn’t exist or match the setting module.

Make sure that the setting module matches for the device that is being

plugged and check your module is plugged in ADAM-5560 appropriately.
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0x8001

The system failed to open the module.

Please close all programs and reboot. If the system cannot returns to normal
condition or the error occurred, please contact Advantech for technical

support.

0x8002

The system was unable to complete configuration.

Please power-off the system and plug the module again. If the error occurred,

please replace a new module and contact Advantech for technical support.

0x8003

The system failed to read value from the module.

Please power-off the system and plug the module again. If the error occurred,

please replace a new module and contact Advantech for technical support.

0x8004

The system failed to write value to the module.

Please power-off the system and plug the module again. If the error occurred,

please replace a new module and contact Advantech for technical support.

0x8005

For counter module, the system failed to start/stop counter.

Please power-off the system and plug the module again. If the error occurred,

please replace a new module and contact Advantech for technical support.

0x8006

For counter module, the system failed to clear counting value.

Please power-off the system and plug the module again. If the error occurred,

please replace a new module and contact Advantech for technical support.

0x8007

For counter module, the system failed to clear overflow flag.

Please power-off the system and plug the module again. If the error occurred,

please replace a new module and contact Advantech for technical support.

0x8008

For counter module, the system failed to clear alarm flag.

Please power-off the system and plug the module again. If the error occurred,
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please replace a new module and contact Advantech for technical support.
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